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1. Introduction to Kernel for Windows Data Recovery

Welcome to the user manual of Kernel for Windows Data Recovery, the most effective and easy-to-use data recovery
software that helps you to recover data from lost, deleted, formatted and corrupted partitions where FAT and NTFS based
operating system, such as Windows 95, Windows ME, Windows 98, Windows NT, Windows 2000, Windows 2003, Windows
XP, Windows Vista, Windows 7, Windows 8, Windows 8.1, and, Windows 10 are installed on the hard disk or data storage
media. This user manual comprises step-by-step guidelines on using Kernel for Windows Data Recovery.

1.1 Using this Manual

This user manual is intended to guide users on using Kernel for Windows Data Recovery. We suggest that first time users
should read this user manual completely and carefully before proceeding to use the software. However, if you are an
experienced user, you can use the table of contents to find out information pertaining to the tasks that you need to perform
by using Kernel for Windows Data Recovery.

You can use the table of contents to navigate through different sections of this user manual. The table of contents lists all the
sections that are contained in this user manual in chronological order. The user manual comprises the following sections:

e Introduction

e  Getting Started

e Software Interface

e Recovering Windows Data
e Full Version

e Support

e Troubleshooting

e |egal Notice

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of this user
manual, please go through the list of abbreviations, mentioned below, before reading the manual.

1.1.1 List of Abbreviations

e FAT: File Allocation Table
e NTFS: New Technology File System

e RAM: Random Access Memory

[KERNEL A
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e MB: Mega-Byte

o (B: Giga-Byte

1.2 About Kernel for Windows Data Recovery

Kernel for Windows Data Recovery is an effective, stupendous, and result-oriented FAT and NTFS data recovery software. The
software effectively recovers data from the corrupt, damaged, or virus-attacked FAT16, FAT32, NTFS, and NTFS5 partitions.
The software confirms an assured recovery of lost data. The data, which has been deleted from the Recycle Bin or using SHIFT
+ DELETE key can also be recovered with Kernel for Windows Data Recovery software. Following are the reasons that generally
lead into data loss:

e Accidental or intentional formatting of hard disk partitions

e Accidental file deletion

e Virus attack

e Corruption of hard disk partition(s)

e Damage or deletion of partition structures

e Unexpected system shutdown

e Software failure

e Corruption of Windows file system(s)

e Accidental or intentional deletion of data stored on hard disk

The software is equipped with three recovery modes: Quick Scan, Deep Scan, and File Trace. These recovery modes
enable the user to recover the lost data based on the various data loss situations. Kernel for Windows Data Recovery
software maintains the logical structure, formatting, and properties of the recovered files and folders. While recovering

the lost files, the software arranges them in their respective folders. In case, the parent folder of the recovered files is
not found then the software creates a folder named Lost Dir and saves the recovered individual files in that folder.

With Kernel for Windows Data Recovery software, a user can impeccably recover data from existing logical drives and
the hard disk partitions, as well. In some cases, it may happen that you do not see the hard disk partition from which
you want to recover the lost data. At that time, you can use the Search Partition option of the software to locate the
missing partition to continue the data recovery. Brief about the available data recovery modes in Kernel for Windows
Data Recovery software is given below:

Quick Scan is a fast recovery mode, which assures data recovery of deleted files, files lost due to bad sectors, boot
sector corruptions, FAT corruptions, index corruptions, partition deletions, MFT corruptions, virus attacks, media
errors, etc. The recently deleted file(s) are effectively recovered by this mode of recovery.

o KERNEL
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Deep Scan is an advanced recovery mode, which recovers data lost due to partition format, partition deletion, and re-
formatting of hard disk partitions. This mode should be selected when you want to recover the files and folders that
were deleted long time ago. You can also select this mode when the Quick Scan mode does not recover the desired
files and folders.

File Trace is a slow but effective recovery mode, which extensively scans the corrupt partition or drive to recover data
from it. This recovery mode takes time in data recovery as it searches for lost data in sectors of the drive and then lists
them to you. This mode enables you to search for specific file types to speed up the recovery process. For example, if
you want to recover only .doc files then the software will only search for .doc files on the selected hard disk partition
or logical drive.

The File Trace mode should be selected when Quick Scan and Deep Scan modes are unable to recover the lost data.

1.3 Salient Features

Kernel for Windows Data Recovery software incorporates a myriad of outstanding features that make data recovery
simple and effective. Following are the software features:

* Recovers data from Physical device as well as Logical device.
* Recovers the data lost due to corruption, formatting, or re-formatting of the hard disk partitions.

e Recovers all types of files, such as images, video files, music files, database files, email files, media files,
archive files, and graphic files.

e Comprises three recovery modes: Quick Scan, Deep Scan, and File Trace to help you recover data based on
various data loss situations:

o Quick Scan: This is the fastest recovery mode, which helps you recover the files and folders that are
deleted recently. This mode can also be used in case the data is lost due to damage of MFT, corruption
of the file system(s), presence of bad sectors on disk, and Index corruption.

o Deep Scan: This mode is comparatively slower than the Quick Scan mode. Using this mode, you can
recover those files and folders that Quick Scan mode fails to recover. The mode works well in case the
data is lost due to hard disk formatting, deletion of hard disk partitions, and recreation of hard disk
partitions.

o File Trace: It is the slowest but the most efficient data recovery mode of the software. The mode scans
the complete hard disk drive sector by sector to recover the maximum data. One should use this mode
when both Quick Scan and Deep Scan modes get failed to produce the desired result. Using this mode,
the user can even recover the files that were deleted long back. Displays the recovered folders in a
tree-like structure to ease the search process.

e Displays the deleted files (that are now recovered) in Red color for their quick identification.

e Comprises Find Files option that helps you search for a specific type of files in the recovered data.

o KERNEL
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e Enables you to preview the recovered files before saving.

e Comprises the Save Snapshot and Load Snapshot features that help you save the recoverable data as a snapshot. The
saved snapshot can be loaded anytime using the Load Snapshot option to continue the recovery process. The Save
Snapshot and Load Snapshot features are beneficial when you do not have much time to sit and wait for the recovery
process to finish. You can save the recoverable data on your computer’s hard disk and later on by loading the
snapshot you can move ahead with the recovery process.

e Enables you to configure software settings based on which the software will recover the lost data. Settings that can
be configured are:
o Sectors to be read in one attempt

o Rename, overwrite, or skip the duplicate files

o Include deleted files in the search, exclude deleted files from recovered files, or only recover the
deleted files

o Number of retries on bad sectors

e Provides full support for long file names.
e Supports all types of drives, such as IDE, EIDE, SCSI, SATA, PEN, ZIP, and USB drives.

e Recovers data from the drives that appear as Logical Drive in your computer.

e Provides full support to FAT 16, FAT 32, NTFS, and NTFS5 file systems.

e Provides full support to Windows XP, Windows Vista, Windows 7, Windows 8, Windows 8.1, Windows 10, Windows
Server 2000, Windows Server 2003, Windows Server 2008, Windows Server 2008 R2, and Windows Server 2012
Operating System platforms.

e Round the clock technical support.

1.4 Who Should Use this Software?

The capability and potential of Kernel for Windows Data Recovery to recover deleted, damaged and formatted windows hard
drive partition make it appropriate for every condition. Previously, the hard drive recovery was manually performed by
professionals or experienced user.

Now with Kernel for Windows Data Recovery, any inexperienced or home user can easily use it to recover the data from the
corrupt, formatted and deleted partitions which leads to data loss scenarios. The data loss scenarios could have been caused
due to accidental file deletion, file system corruption, operating system corruption, erroneous hard drive format operations
and other logical problems to your computer system.

1.5 System Requirements

Before you start installing Kernel for Windows Data Recovery software, make sure that your computer meets the
following system requirements:

o KERNEL
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Hardware Requirements:

The hardware requirements for installing the software are as follows:

¢ Pentium Class Processor

e 64 MBRAM (128 MB Recommended)

®* 10 MB of free disk space for software installation

Supported Windows OS Platforms:

e Windows XP

e Windows Vista

e Windows 7

e  Windows 8

e Windows 8.1

e Windows 10

e Windows 95/NT

e  Windows XP

e Windows Server 2000
e Windows Server 2003
e Windows Server 2008
e Windows Server 2008 R2
e Windows Server 2012

Supported File Systems
e FAT16
e FAT 32
e NTFS
e NTFS5
Note:

W You should have enough space on your computer’s hard disk or on any other storage media to save the
recovered data.

[KERNEL A
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2. Install and Uninstall

After checking your computer with the prescribed system requirements for Kernel for Windows Data Recovery, you can
download and install this software on your computer.

2.1 Install Kernel for Windows Data Recovery

After being familiar with the software overview, key features, and system requirements let us install the software. However,
before installing the software you must ensure that the software installer file is available on your computer. If the file is not
available on your computer then you can download the file  from our Website-
https://www.nucleustechnologies.com/Data-Recovery- Software.html.

After you have downloaded the installer file, execute the following steps to install the software:

¢ Double-click the installer file of Kernel for Windows Data Recovery software.

* Follow the on-screen instructions. When the installation process completes “Setup Installation Complete”
message appears on the software installation screen.

¢ (Click the Finish button to launch the software.
2.2 Uninstall Kernel for Windows Data Recovery

You can uninstall the Kernel for Windows Data Recovery software from your computer system by using one of the following
two methods:

e Uninstall from Windows Start Menu

¢ Uninstall from Control Panel

Note:

. Before starting the uninstallation process, make sure that the Kernel for Windows Data Recovery software is
not in use.

2.1.1 Uninstall from the Windows Start Menu

Execute the following steps to uninstall Kernel for Windows Data Recovery from Windows Start menu:

1. Click Start > All Programs > Kernel for Windows Data Recovery > Uninstall Kernel for Windows Data Recovery.
A warning message before uninstalling the software will be displayed on the screen.

2. Click the Yes button to uninstall the software.

3. Click the OK button.

‘ o [KERNEL Al
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Kernel for Windows Data Recovery is successfully uninstalled from your computer system.

2.2.1 Uninstall from control Panel

Execute the following steps to uninstall Kernel for Windows Data Recovery from Control Panel:
1. Click Start > Control Panel. The Control Panel window appears.
2. Double-click the Add or Remove Programs icon. A list of the programs installed on your computer appears.

3. Select Kernel for Windows Data Recovery and click the Remove button. A warning message before uninstalling
the software will be displayed on the screen.

4. Click the Yes button to uninstall the software.
5. Click the OK button.

Kernel for Windows Data Recovery is successfully uninstalled from your computer system.

[KERNEL A
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3. Understanding the User Interface

Now that Kernel for Windows Data Recovery has been installed on your computer, you can start using the software after
getting acquainted with the software interface.

3.1 Menu Bar

The Menu bar of Kernel for Windows Data Recovery comprises following main menus:

e Recovery Menu
e View Menu
e Tools Menu
e Help Menu

3.1.1 Recovery Menu

Recovery menu of the Kernel for Windows Data Recovery software appears, as shown in following figure:

Recovery | View Tools Help

Becover Selected...

Save Recovery Snapshot...

TR

Figure 3.1: Recovery Menu

Following table enlists the options available in the Recovery menu:

Recover Selected Select this option to start the process of saving the recoverable data.

Select this option to save the recoverable data as snapshot when you
Save Recovery Snapshot | do not have time to sit and wait for the data to be saved on your
computer’s hard disk or another storage media.

Load Recovery Snapshot | Select this option to load the saved snapshot.

Exit Select this option to close the software.

[KERNEL A
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3.1.2 View Menu

The View menu allows you to change the pattern of viewing the recovered file(s) in the software. View menu of the Kernel
for Windows Data Recovery software appears, as shown in following figure:

Yiew | Tools

Icons
List
Details

Figure 3.2: View Menu
Following table enlists the options available in the View menu:
Icons Select this option to view the recovered files in

form of icons.

List Select this option to view the recovered files in a list-like structure.

Select this option to view the recovered files with complete details like size,
Details type, date, etc.

3.1.3 Tools Menu

Tools menu of the Kernel for Windows Data Recovery software appears, as shown in following figure:

Tools | Help

(%, Find Files

File Filters
Settings

P

,_
T
12

Drive Information

Figure 3.3: Tools Menu

. - JKERNEL /4
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Following table enlists the options available in the Tools menu:

Select this option to find specific file(s) from the recovered file(s). For example,

Find Files you need to view .xls files then type * xlIs in “Find Files” dialog box and the
software will display all the MS Excel file(s) amongst the recovered files.

This option works similar to the Find Files option. However, the only difference
among both is using the Find Files option, you can search for a specific type of
File Filters | files, say *.xIs but with the File Filters option, you can specify multiple file types,
say *.xls, *.docx, *.pdf, etc. Based on the file type(s) you specify, the software
displays the recovered items.

Select this option to configure following software settings based on which the
software will search the lost files and folders:

Sectors to be read in one attempt

Settings e Rename, overwrite, or skip the duplicate files
Include deleted files in the search, exclude deleted files from recovered
files, or only recover the deleted files

e Number of retries on bad sectors

Drive Select this option to gather information about the system drive.
Information
. . . ’fd-J‘ ﬁ'lﬁ
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3.1.4 Help Menu

Help menu of the Kernel for Windows Data Recovery software appears, as shown in following figure:

Help |

(Z) Help

Buy Online

Activate Mow

About Kernel for Windows Data Recovery

Figure 3.4: Help Menu

Following table enlists the options available in the Help menu:

Help Select this option to view Help manual of the software.

Buy Online Select this option to purchase the software online

Activate Now | Select this option to view software version information and support details of the software.

About Kernel
for Windows | Select this option to activate the software.
Data Recovery

3.2 Toolbar

Tool bar consists of buttons that work as shortcuts for various options available in the main menus of Kernel for Windows
Data Recovery software. Following table enlists the buttons available on the Tool bar of the software:

. - JKERNEL /4
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)

Click this button to start the saving process.
Recowver

[=== ]
B Click this button to save the recovery snapshot.

Save Snapshot

[ees ) . .
Click this button to load the recovery snapshot.
Load Snapshot

Q Click this button to enter and search specific file types amongst thousands of file(s)
Eind recovered by the software.

Click this button to view and modify following software settings based on which the software
will search the lost files and folders:

@ e Sectors to be read in one attempt
[ ]

5 Rename, overwrite, or skip the duplicate files
e Include deleted files in the search, exclude deleted files from recovered files, or only
recover the deleted files
e Number of retries on bad sectors

®

. Click this button to view Help manual of the software.
elp

. - JKERNEL /4
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There are several buttons used in the software that helps you throughout the recovery process. Following table
lists the buttons used in the software:

O Click this button to start the saving process.

Recover

Click this button to hide the searching process. While searching for the files
and folders on the selected hard disk partition or logical disk drive, the
software displays the progress. If you do not want to see that progress, then
just click the “Hide Progress” button. Clicking the “Hide Progress” button also
improves the recovery speed

Hide Progress

Click this button to view the searching progress

‘ Show Progress

Next @ Click this button to proceed to next step during the recovery process.
@ Back Click this button to navigate back during the recovery process.
Stop @ Click this button to stop the searching or saving process in-between.

4. Using Kernel for Windows Data Recovery

Now that you have got familiar with the user interface of Kernel for Windows Data Recovery, you are ready to
recover Windows data from physical devices and logical drives.

4.1 Recover Data from Physical and Logical Devices

Whether you have one hard disk in your computer or two, Kernel for Windows Data Recovery software enables you
to recover the lost data from all hard disk attached to the computer. Whatever is the reason behind the data loss
be it hard disk formatting, OS corruption, or accidental files deletion, Kernel for Windows Data Recovery thoroughly
scans the selected hard disk to provide you with the recovered data. The software provides you following modes

© KernelApps Private Limited nntrfngc'o;’iﬂ ’
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to recover the lost data from hard disk:

e Quick Scan
e Deep Scan

®  File Trace

4.1.1 Using the Quick Scan Mode

The Quick Scan mode is the fastest mode of data recovery. It enables you to recover the recently deleted files and
folders, data lost due to recent formatting of hard disk partitions, etc. Execute the following steps to recover the
lost data using the Quick Scan Mode:

1. Select Start > All Programs > Kernel for Windows Data Recovery > Kernel for Windows Data Recovery
to launch the software. The software home Window appears providing you an overview about the
available recovery modes:

[ [@) Kernel for Windows Data Recover
Recovery View Tools Help

' @ ® Kernel

s for Windows Data Recovery
Setting Help =

Step 1: Select Recovery Mode

Please select scan mode for recovery. Select Quick Scan to recover recently deleted files. Select Deep Scan for case
hard disk format. If both modes fail then use FileTrace scan.

Quick Scan Deep Scan File Trace

Please Select Recovery Option.

CAP NUM S5CRL .

Figure 4.1: Main Window

2. Click on the Quick Scan icon to recover the recently deleted data.

© KernelApps Private Limited m‘r:’n;;ogiﬂ ’
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[ [@] Kernel for Windows Da
Recovery View Teools Help

{@} @ Kernel
for Windows Data Recovery

Setting Help 5

Step 1: Select Recovery Mode

Please select scan mode for recovery. Select Quick Scan to recover recently deleted files. Select Deep Scan for case
hard disk format. If both modes fail then use FileTrace scan.

Quick Scan Deep Scan File Trace

Select the Quick Scan mode for the recovery of recently deleted file(s) and folder(s).

CAP NUM SCRL

Figure 4.2: Scanning Modes

3. Select a Logical device from which you want to recover the data. When you select the Disk, the
information, such as capacity of the hard disk, partition types, etc. appear. Click on the Next button
to continue.

© KernelApps Private Limited nﬁn&iﬁ ’
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Kernel for Windows.

Recovery View Tools Help

' @ @ Kernel

o i : for Windows Data Recovery
Recover | Save Snapshot Load Snapshot Find Setting Help =

Step 2: Select drive to recover

-4 My Computer
£-%e Physical Devices
¢ .2 Hard DiskD
% Logical Devices
il Drves . _
< Logical Drives D: ~5Selected Drive Information
Volume Mame : WindowsT
Capacity : 99899 MB (Approx)
SPC : 8
Byte Per Sector : 512
File System : NTFS

Please select the logical drive that contains inaccessible data from left panel. If you don't see the drive letter, then select the hard
disk, which contains the lest drive and click [MNext] to continue with recovery.

/// Used: 34.55 GB

Free: 63.01 GB

Selected Mode : Quick Scan
Drive Type : Logical Drive

Ready

Figure 4.3: Quick Scan Window

Moving forward, the tool will show you the disk information, click on Next to proceed.
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Kernel for Windows

Recovery View Teools Help

@ @ Kernel

s for Windows Data Recovery
Setting Help =

Step 3: Press next to continue

You have selected logical drive for recovery. Please click [Next] to continue with recovery.

~5Selected Drive Information
Volume Name : Windows7 { C:\)

Capacity : 99899 MB (Approx)
SPC : 8

File System - NTFS

’/_// Used: 3455 GB

Free: 63.01 GB

Selected Mode - Quick Scan

Drive Type - Logical Drive @ Back || Next @
Ready

CAP NUM SCRL

Figure 4.4 Disk Information

5. Now, let the scanning process finish to search the data for recovery.
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Kernel for Windows Data

Recovery View Tools Help

Installation & Configuration Guide

Kernel
for Windows Data Recovery

Please wait... Searching data

Searching for lost data. Please wait...

~Selected Drive Information
Folder(s) Found : 13700
File(s) Found 8050
Current Sector - 6335090
Last File/Folder - index_dat

/_/ Used: 34.55 GB
Free: 63.01 GB

Reading Sector 43600 Of 201216

I 21%

Selecting "Hide Progress” will improve the performance. You may return
to view the progress details at any time by selecting "Show Progress”.

Hide Progress

Selected Mode - Quick Scan
Drive Type - Logical Drive

Ready

Stop @

CAP NUM SCRL

Figure 4.5 Data Search

Note:

information.

™. Click the Hide Progress button to improve the performance of data searching and hide the progress

. Click the Stop button to stop the searching process anytime.

6. Once the process is over, the tool will show you a notification, if any required file is missing in
quick search, you can go for better and intense scanning modes like Deep Search.

© KernelApps Private Limited
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,
E el for Wi O Recovery S, (= (e =

Recovery View Tools Help
@ @ Kernel
for Windows Data Recovery

Find Setting Help

mecover 23VE of

| Step 4: Select to recover

=0 Root File Name | Type Size Creation Time Madification Time ] =
E:""g b ;E"te”‘: . O |. SExtend Folder 0 3-9-2019 22:14:43 3-9-2019 22:14:43 13347072
|| ED S ;?'c sEn O || SRecycle.Bin Folder 0 2.9-2010 22:21:1 292019 22:21:1 13247101/ %
. Perflogs
o0 . pmgrafn Filee O || PerfLogs Folder 0 3-9-2019 22:211 3-9-2019 22:21:1 13347123
- ] O . Program Files Folder ] 3-9-2019 22:21:1 3-9-2019 22:21:1 13347137
m-0 | Pregram Files (x86) - .
w0 | ProgramData O [ kernel for Windows Data 13343033
@0 ) Users o 13348700
-0 [ Windows U If yvou don't find the required file(s) and folder(s) here then please go back 46437440
..... O |, Documents and Setting O to the first step and select Deep Scan for recovery. 46092688
-0 | System Volume Inform O 85350464 i
-0 |, Recovery o - et
50 e ook
w00 |, SWTOOLS
@00 1) Lost Dir
Select file for preview
< I | »
Selected Mode - Quick Scan @ Back || Recover @
Drive Type : Logical Drive
Ready CAP MUM SCRL
L . = =
Figure 4.6 Select to Recover
7. At this stage, you can have the preview of the files by selecting them, as shown in the screenshot
below.
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Kernel for Windows Data Recover

Recovery View Tools Help

= ==
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Figure 4.7 Select to Preview

8. Select all the folders you want to recover and click on the Recover button.
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Recovery View Tools Help
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Figure 4.8 Recovery Window

9. Provide a destination to the file by selecting an appropriate folder and click on the OK button to
save the recovered files.
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Figure 4.9 Browse the Folder
10. The system will start to save the file at the specified location. Wait for the Saving process to finish.
. L IKERNEL A4
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Kernel for Windows Data Recovery | = | Bl £ |
Recovery View Tools Help
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: ) ! for Windows Data Recovery
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Figure 4.10 Saving Process
Note:

click the Skip File button.

™. You can stop the saving process by clicking the Stop Saving button or if you want to skip any file from saving,

11. Once the saving process is finished, click on the Ok button.
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Figure 4.11: Successful Completion of Saving Data Window

4.1.2 Using the Deep Scan Mode

The Deep Scan mode allows you to recover data from the formatted, corrupt, deleted, or recreated partitions.
This mode is slower than the Quick Scan mode; therefore, it should be used when you do not get satisfactory
output from the Quick Scan mode. Following steps help you to recover data using the Deep Scan mode:

1- Start the software.

2- Click the Deep Scan icon.
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J| Kernel for Windows Data Re

Recovery View Tools Help

@ Kernel
for Windows Data Recovery

Step 1: Select Recovery Mode

Please select scan mode for recovery. Select Quick Scan to recover recently deleted files. Select Deep Scan for case
hard disk format. If both modes fail then use FileTrace scan.

Quick Scan File Trace

Select the Deep mode for recovery in case of Hard disk format, partition deletion, recreation, etc...

CAP NUM SCRL

Figure 4.12 Selecting Deep Scan Mode

3- All Physical Device(s) and Logical Drive(s) available in your computer appear.

4- Select a Hard Disk under the Physical Device category from which you want to recover the data. When
you select the Disk, the information, such as Model number of the hard disk, capacity of the hard disk,
partition types, etc. appears in the right panel.

5- Click the Next button to move ahead in the recovery process. The “Please Select” dialog box appears.
Select the “Use existing partition info” radio button to recover the data from an existing partition on
the selected hard disk. If you cannot see the partition in the hard disk, then select the “Search partition”
radio button to search the lost hard disk partition.

6- Select an appropriate option and click the OK button. On selecting the appropriate option, the software
lists the available partitions in the left panel.

7- Select a partition. The software displays the partition configuration and also allows you to change the
file system of the selected partition. You can change the file system by clicking the drop-down arrow
beside the “Select File System” drop-down list.
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8- Click the Next button. The software starts searching for the recoverable data.

Note:

W’ Click the Hide Progress button to improve the performance of data searching and hide the progress
information.

™ Click the Stop button to stop the searching process anytime.

After the searching process is completed, all recoverable files are displayed in a tree-like structure in the left
panel of the software window.

9- Select a folder in the left tree whose content you want to verify before saving. When you select the
folder, its content will get listed in the right panel.

10- Now, select an item from the list in the right panel to have a preview. As soon as you will select the
item, the software will display the preview on the screen.

Recowver

11- After previewing the required items, select them for saving and then click the button. The

“Browse for Folder” dialog box appears.

12- Specify a location to save the selected items and then click the OK button. The software starts saving
the selected items at the specified location.

Note:

™. You can stop the saving process by clicking the Stop Saving button or if you want to skip any file from saving,
click the Skip File button.

After the saving process is completed, a dialog box displaying the “Files Saved Successfully” message appears.

13- Click the OK button to close the dialog box.

Now, you can view the recovered file(s) from the saved location.

4.1.3 Using the File Trace Mode

It is the slowest mode of data recovery. This mode scans the hard disk partition sector by sector to recover the
maximum data. Following steps help you to recover data using the File Trace Scan mode:

1. Start the software.
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2. Click the File Trace icon.

@] Kemel for Windows Data Recc

Recovery View Tools Help

® Kernel
for Windows Data Recovery

Step 1. Select Recovery Mode

Please select scan mode for recovery. Select Quick Scan to recover recently deleted files. Select Deep Scan for case
hard disk format. If both modes fail then use FileTrace scan.

Quick Scan Deep Scan File Trace

Select the File Trace mode if both Quick scan and Deep scan mode do not work for you.

CAP NUM SCRL |

Figure 4.13 Selecting File Trace Scanning Mode

3. All Physical Device(s) and Logical Derive(s) available in your computer appear.

4. Select a Hard Disk under the Physical or Logical Devices node from which you want to recover the data.
When you select the Hard Disk, information, such as Model number of the hard disk, capacity of the hard
disk, partition types, etc. appears in the right panel.

5. Click the Next button to move ahead in the recovery process. The “Please Select” dialog box appears.
Select the “Use existing partition info” radio button to recover the data from an existing partition on the
selected hard disk. If you cannot see the partition in the hard disk, then select the “Search partition” radio
button to search the lost hard disk partition.

6. Select an appropriate option and click the OK button. On selecting the appropriate option, the software
lists the available partitions in the left panel.

7. Select a partition. The “File Types” dialog box appears:
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\What file types would you like to recover? [Please check file
|| types] and click [Ok] to continue with recovery.

=1 [ File Types

B | Archive Files

#-4 || Document Files

&b || Database Files

-0 || E-mail Files

-k || Graphics Files

- || Sound Files

-0 . Media Files

&b | Intemet Files

& . CAD Files

&b || Other Files

Select File Size: 2MB -
[ ]9 ] [ Cancel ]

Figure 4.14 Partition Selection Window

8. Select the file types that you want to recover and click OK to continue with the data searching process.

9. Asyou click the OK button the software starts searching for the recoverable data.

Note:

W@, Click the Hide Progress button to improve the performance of data searching and hide the progress
information.

. Click the Stop button to stop the searching process anytime.

After the searching process is completed, all recoverable files are displayed in a tree-like structure in the left panel
of the software window.

10. Select a folder in the left tree whose content you want to verify before saving. When you select the folder,
its content will be displayed in the right panel.

11. Now, select an item in the right panel to preview the selected item. The software displays the preview of
the selected item.
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e

Recower

12. After previewing the required items, select them for saving and then click the
“Browse for Folder” dialog box appears.

button. The

13. Specify a location to save the selected items and then click the OK button. The software starts saving the
selected items at the specified location.

Note:

W™ You can stop the saving process by clicking the Stop Saving button or if you want to skip any file from saving,
click the Skip File button.

After the saving process is completed, a dialog box displaying the “Files Saved Successfully” message appears.
14. Click the OK button to close the dialog box.

Now, you can view the recovered file(s) from the saved location.

Note:

. In this mode, deleted files are not displayed in Red color. Moreover, original file names are not recovered;
therefore, files are named numerically in a proper sequence.

4.2 Preview Recovered Files

Kernel for Windows Data Recovery can recover every type of file from corrupt drive. The software recovers every
file type and enables you to preview the recovered file(s). While previewing the selected file, you may get following
message(s):

o Select file for preview: This message is displayed when the software prompts you to select the file to
preview.

e Preview not available for this file type: This message is displayed when the preview of certain file type is
not available. The software supports preview of certain recovered file types, which are mentioned below.

o File Corrupted: This message is displayed when the recovered file is corrupted. The software will not
display preview of the file which is corrupt.

e File too large to preview: This message is displayed when file size of the recovered image or file is too
large to preview. This does not mean that the image or file is not recovered; the file is recovered but
software will not display its preview because it is too large to preview. The recovered file can be viewed
when you save the recovered results.
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Supported File Types for Preview:

A . ~ = Archive Database Web
Graphic Files Document Files Media Files Files Files Files
e .pdf avi zip .dbf Ll
.png ot WMV .cab .mdb -htm
J2k .doc .asf rar -mht
Jp2 xls SWm tar
J2c kdoc Wma
Jpc .ppt WY
Jpg xt SWav
Jpeqg .C .snd
.pcx .cpp .au
.png .h Laif
.pnm .hpp .mpeg
.pam .ini .mpag
.ppm xml .milv
.tga .mp2
if mpa
hiff .mid
.gif i
.emf .midi
.ico .dvr-ms
.psd .35
Jduf Wax
WX
WX
.mid
rmi
.mp3
.dat

5. Understanding Other Useful Options

Kernel for Windows Data Recovery software is an output-driven utility that can even recover the file(s) or folder(s)
that are deleted by pressing the SHIFT + DELETE key. Possessing an exceptional ability to recover data even from
the deleted, formatted, and re-formatted partitions, there are few other important options that an individual
need to understand about this software like:

e Configure Software Settings

e Save Snapshot

e |oad Snapshot

e Find File(s)
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e File Filters
e Drive Information

2.1 Configure Software Settings

Kernel for Windows Data Recovery software allows you to define the recovery settings. These settings can be
defined at the beginning of the recovery process i.e. when you start the software. Following steps help you to
configure software settings:

1. Start the software.

2. Select Settings. The “Recovery Settings” dialog box appears:

Recovery Settings u1

Sectors to read in single attempt

| Sectors o read in gingle attempt

Setting of duplicate file(s)

@ Rename duplicate file(s)

() Ovenite duplicate filefs)
(") Skip duplicate file(z)
Setting for deleted file(s)
@ Inchude deleted fils(z)
(") Recover only deleted file[s)

() Exclude deleted file(z)

Setting for bad sectors

Mumber of reties on bad sector(z)

[ Ok, ] [ Cancel ]

Figure 5.1 Recovery Setting Window

3. Define the settings as per your need and click the OK button. The software will then function
according to the saved settings.
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5.2 Save Snapshot

"Save the scanning process of the drive in Evaluation version and load it in Full version”

Kernel for Windows Data Recovery software enables you to save the scanning process of your corrupt hard drive.
This facility helps you in terms of scanning the drive again and again. As Evaluation version of the software does
not allow you to save the recovered files, the Save Snapshot option becomes helpful to users in such a case. You
can upload the saved snapshot in Full version of the software to save the time of scanning the drive once again
and to make the recovery process fast.

The Save Snapshot option is disabled by default. It will be enabled when the software has displayed the files that
can be recovered. Once the software has displayed the files that can be recovered, execute the following steps to
save the recovery snapshot:

=)
=

Save Snapshot

1. Click the Save Snapshot icon. The “Save As” dialog box appears:

Lo | seocnvesir 5]

Organize - Mew folder

i Favorites = = |ibraries
Bl Desktop I Systemn Folder

4. Downloads

=l Recent Places = ] Manisha Rawat
& Onelrive & System Folder

- . | Computer
7 Libraries 4*} System Folder

@ Documents

o) Music Metwork
[&] Pictures | System Folder

H videos

~ [l Shdend

File name: | ENE il

Save as type: |*.nkfn

“ Hide Folders

Figure 5.2 Saving Snapshot

2. Type a name for the recovery snapshot in the File name drop-down list.
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3. Specify a location to save the snapshot.
4. Click the Save button to save the snapshot.

The snapshot will be saved in .nkfn format.

5.2 Load Snapshot

“Load the Saved Snapshot of the scanning process and save your precious time” is the aim of embedding the Load
Snapshot feature in the software. The Load Snapshot feature saves the time of rescanning the selected drive for
data recovery. Execute the following steps to load the saved snapshot:

1. Start the software.

2. Select a scanning mode. The “Load Snapshot” option will be active.

Load Snapshot

3. Select Load Snapshot

LES =

icon. The “Open” dialog box appears:

o
‘€
e
Organize * Mew folder
n "Ij File folder

0 Favorites

B Desktop || swroots
4 Downloads h | Filefolder

i
1= Recent Places

& OneDrive ' Users
L’J File folder

1 Libraries
@ Documents

J‘F Music

[ Pictures dd.nkfn

E Vid — Kernel Docurment
1eees 7] 12.7 MB

- jhjk.nkfn
1% Computer B Kernel Decument
&, Windows7 (C) ~ 7] 116 MB

File name: dd.nkfn

Windows
1 I File folder

Figure 5.3 Loading Snapshot

4. Select the saved snapshot and click the Open button.
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The software successfully loads the selected snapshot enabling you to continue the recovery process.

5.4 Find File(s)

During the recovery process, thousands of files are recovered. You may not need to save all files that are
recovered. Therefore, in order to help you find a specific file or the files based on a specific file type from
thousands of the files recovered, the Find feature has been embedded in the software. Following steps help you
to use this feature:

1. Click on the Find icon. The “Find Files” dialog box appears:

Find File(s)

Enter pattermn to zearch

Select Al |

File: Hame Fath Size Creation Time e

Lazt File : Filez Faund

Stop Search Save Selected File

Figure 5.4 Find Files Window

2. Type the file name or the file type in the “Enter pattern to search” text box. For example, if you want
to search only documents then type *.doc in the text box.

3. Click the Start Search button. The software starts searching for the available files amid recovered files.

4. After the software has displayed the files, select the files that you want to save and click the Save
Selected File button to save the selected file(s).

Note:

. Click the Stop Search button to stop the searching process in between.
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5.5 File Filters

The File Filters option works similar to the Find File(s) option. The only difference is, using the File Filters

option you can specify multiple file types while using the Find File(s) option only one file type can be
specified.

For example, you want to search files having .doc, .jpeg, and .xIs formats then you add these extensions to
the File Filters dialog box and the software will then display the files related to the specified patterns.

Following steps help you to use the File Filters option:

1. Select Tools > File Filters. The “File Filters” dialog box appears:

Enter Filker

Figure 5.5: File Filter Dialog Box

2. Type a search pattern in the “Enter Filter” dialog box and click the Add button.

3. Repeat step 2 to add multiple search patterns.

4. Click the Close button after you have added all search patterns.

Note:

. Click the Remove button to remove the selected search pattern from added patterns.
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5.6 Drive Information

Kernel for Windows Data Recovery also provides you detailed information about the drives available in your
computer. In order to view drive information, select Tools > Drive Information. The software displays the
information about the drives available:

Drive Information |E|
File Spstem : MTFS
Start Sectar : 0
Direchonies : 3618
Files : 400718
SFC : 8
First FAT : HAA
Second FAT : A2,
MFT Start : G291436

Figure 5.6: Drive Information Window

After you have seen the drive information, click the OK button to close the dialog box.

6. Download Purchase and Register

One can use Kernel for Windows Data Recovery evaluation version for free and experience the capabilities of the
software, but there are certain features that are not available in the evaluation version. In order to experience all
the features of the software one has to purchase the complete and licensed version of Kernel for Windows Data
Recovery software. As soon the purchase transaction with our resellers gets completed, our sales team will send
you an email comprising the URL to download the full version of Kernel for Windows Data Recovery software and
its activation details.

6.1 Free Trial Download

The trial version of Kernel for Windows Data Recovery software is also available, with which you can evaluate and
analyze the capabilities of the software. The trial version of the software works similar to the Full version except
allowing you to save the recovered files and folders. However, the trial version enables you to save the recovered
items in the form of a snapshot, which can be loaded later with the Full version. Saving the recovered items as
snapshot saves your time of rescanning the drive after purchasing the Full version.
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6.2 Purchase and Register

You must purchase Full version of Kernel for Windows Data Recovery software in order to save the recovered files
and folders. The FREE trial version of the software allows you to preview the recovered items but does not allow
saving them. Therefore, to save the recovered items, you need to purchase the software.

You can purchase the software through KernelApps website: https://www.nucleustechnologies.com/Data-

Recovery-Software.html (encrypted and secure site).

Payment and Delivery

Purchase the Kernel for Windows Data Recovery software from our authorized resellers, which provide number of
payment options for your ease - PayPal, FAX, Credit Card, E-cheque, Pay Order, etc.

After making the purchase transaction with our resellers, we send you an email, which consists of activation details
and download link of the Full version comprising of the activation code. This email is sent to the email address,
which you have used while processing the purchase transaction with our resellers.

We suggest you not to use false e-mail address while making the purchase transaction For any other details related
to purchase process, software activation process, email us at: sales@nucleustechnologies.com.

6.3 Support

We have an extensive and efficient support system in place to assist our customers with all issues related to using
Kernel for Windows Data Recovery. The software comes with an embedded help manual that can be accessed by
clicking HelpOContents in the menu-bar. You can also press the F1 key on the keyboard of your computer to access
the embedded help of Kernel for Windows Data Recovery.

We also have live support wherein you can chat with our software experts at:
https://www.nucleustechnologies.com/supportcenter/

To talk on phone with our software experts call:
Helpline:

+91-9818725861

1-866-348-7872 (Toll Free for USA/CANADA)
You can also email us about your queries at;

sales@nucleustechnologies.com for Sales

support@nucleustechnologies.com for Support

contact@nucleustechnologies.com for General Queries
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7.Legal Notices Legal Notices

This section comprises the legal specification about Kernel for Windows Data Recovery and the company
KernelApps Private Limited.

7.1 Copyright Notice

KernelApps Private Limited, Kernel for Windows Data Recovery, accompanied user manual, and documentation are
copyright of KernelApps Private Limited, with all rights reserved. Under the copyright laws, this user manual cannot
be reproduced in any form without the prior written permission of KernelApps Private Limited. No Patent Liability
is assumed, however, with respect to the use of the information contained herein.

7.2 Trademarks

Kernel for Windows Data Recovery ® is a copyright work of KernelApps Private Limited Windows 95®, Windows 98¢,
Windows ME®, Windows NT®, Windows 2000®, Windows 2003®, Windows XP®, Windows Vista®, Windows 7®, and
Windows 8® are registered trademarks of Microsoft Corporation. All other brand and product names are
trademarks or registered trademarks of their respective companies.

7.3 Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject to
change without notice. KernelApps Private Limited provides no warranty with regard to this manual or any other
information contained herein and here by Expressly disclaims any implied warranties of merchantability or fitness
for any particular purpose with regard to any of the foregoing KernelApps Private Limited assumes no liability for
any damages incurred directly or indirectly from any technical or typographical errors or omissions contained herein
or for discrepancies between the product and the manual. In no event shall KernelApps Private Limited, be liable
for any incidental, consequential special, or exemplary damages, whether based on tort, contract or otherwise,
arising out of or in connection with this manual or any other information contained herein or the use there of.

/7.4 License Agreement
Kernel for Windows Data Recovery Copyright © by KernelApps Private Limited

Your Agreement to this License

You should carefully read the following terms and conditions before using, installing, or distributing this software,
unless you have a different license agreement signed by KernelApps Private Limited. The terms and conditions of
this License describe the permitted use and users of each Licensed Copy of Kernel for Windows Data Recovery. For
purposes of this License, if you have a valid license, you have the right to use a single Licensed Copy of Kernel.

Scope of the License

Each Licensed Copy of Kernel for Windows Data Recovery may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All rights of
any kind in Kernel for Windows Data Recovery, which are not expressly granted in this License, are entirely and
exclusively reserved to and by KernelApps Private Limited. You may not rent, lease, modify, translate, reverse
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engineer, decompile, disassemble, or create derivative works based on, Kernel for Windows Data Recovery, nor
permit anyone else to do so. You may not make access to Kernel for Windows Data Recovery available to others in
connection with a service bureau, application service provider, or similar business, nor permit anyone else to do so.

Warranty Disclaimers and Liability Limitations

Kernel for Windows Data Recovery, and any and all accompanying software, files, data and materials, are distributed
and provided as is and with no warranties of any kind, whether expressed or implied. In particular, there is no
warranty for the quality of data recovered. You acknowledge that good data processing procedure dictates that any
program, including Kernel for Windows Data Recovery, must be thoroughly tested with non-critical data before
there is any reliance on it, and you hereby assume the entire risk of all use of the copies of Kernel for Windows Data
Recovery covered by this License. This disclaimer of warranty constitutes an essential part of this License. In
addition, in no event does KernelApps Private Limited authorize you or anyone else to use Kernel for Windows Data
Recovery in applications or systems where Kernel for Windows Data Recovery failure to perform can reasonably be
expected to result in a significant physical injury, or in loss of life. Any such use is entirely at your own risk, and you
agree to hold KernelApps Private Limited harmless from any and all claims or losses relating to such unauthorized
use.

General

This License is the complete statement of the agreement between the parties on the subject matter, and merges
and supersedes all other or prior understandings, purchase orders, agreements, and arrangements. This License
shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and venue for all matters relating to this
License shall be in courts and for a located in the State of Delhi, and you consent to such jurisdiction and venue.
There are no third-party beneficiaries of any promises, obligations, or representations made by KernelApps Private
Limited herein. Any waiver by KernelApps Private Limited of any violation of this License by you shall not constitute,
nor contribute to, a waiver by KernelApps Private Limited of any other or future violation of the same provision, or
any other provision, of this License.

END
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